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ВСТУП 

 

 Актуальність дослідження. 3D моделювання відіграє важливу 

роль в житті сучасного суспільства. 3D моделювання сьогодні 

використовується в: 

 Створення різних моделей персонажів. Зазвичай це 

використовується при створенні мультфільмів і при проектуванні 

сучасних комп'ютерних відеоігор. 

 3Д візуалізація будівель. Цим займаються проектні організації, які 

бажають оцінити для замовника конструктивні особливості 

майбутнього об'єкта. 

 Створення 3Д моделей предметів інтер'єру. У більшості випадків їх 

виконують дизайнерські компанії з метою демонстрації естетичних 

властивостей представлених експозицій. 

 Реклама і маркетинг. Часто потрібні нестандартні об'єкти для 

рекламування. Важливу складову тривимірна графіка відіграє при 

демонстрації будь-якої послуги. 

 Виготовлення ексклюзивних прикрас. Професійні художники і 

ювеліри використовують спеціальні програми, які дозволяють 

створити оригінальний і неповторний ескіз. 

 Виробництво меблів і комплектуючих. Виробничі меблеві компанії 

нерідко використовують розробку тривимірної моделі для 

розміщення своєї продукції в електронних каталогах. 

 Промислова сфера. Сучасне виробництво неможливо уявити без 

моделювання продукту компанії. Кожну деталь або повноцінний 

об'єкт простіше збирати по готової і продуманій 3D-моделі. 

 Медична сфера. Наприклад, при проведенні пластичної операції 

або ж хірургічному втручанні, все частіше використовують 
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тривимірну графіку для того, щоб наочно продемонструвати 

пацієнтові, як буде проходити процедура, і яким буде результат.  

 3Д-моделювання дозволяє створити прототип майбутньої споруди, 

комерційного продукту в об'ємному форматі. Важливу роль 3D 

моделювання відіграє при проведенні презентації та демонстрації 

будь-якого продукту або послуги. 

 Завдяки появі і популяризації 3D-друку 3D-моделювання перейшло 

на новий рівень і стало потрібне як ніколи. Кожна людина вже може 

розпечатати намальований ним самим або завантажений з інтернету 3D-

об'єкт, будь то дизайнерська модель або персонаж улюбленого 

мультфільму. Природно, не всі розбираються в 3D-програмах і вміють 

моделювати об'ємні об'єкти. Blender (Блендер) - це проста в освоєнні, але 

потужна програма для створення і роботи з комп'ютерною графікою. 

Можливості Blender включають функціонал для 3d моделювання, 

анімації моделей і об'єктів, скульптінга і композітінга, а так само 2d 

малювання, створення 2d анімацій і навіть відеомонтажу. Blender 

дозволяє вирішити практично всі завдання в комп'ютерній графіці:2d, 3d, 

скульптинг, система вузлів, купа матеріалів, рендеринг,і якщо потрібно 

навіть на відеокарті з підтримкою всіх сучасних технологій. 

 Blender – має стабільний двигун з налагодженим кодом, що 

дозволяє працювати без підвисань і збоїв, підтримує всі найбільш 

популярні формати даних і більшість сучасних особливостей і технологій 

в 3d графіці. 

 Об’єктом дослідження є  технології створення 3D-моделі. 

 Предметом дослідження постають технології створення 3D моделі 

засобами blender. 

 Мета дослідження полягає в розробці 3D-моделі парку Херсонська 

фортеця. У зв'язку з поставленою метою було визначено такі завдання: 

 Проаналізувати інструменти Blender; 

 Проаналізувати Модифікатори Blender;  
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 Описати інструменти та модифікатори при розробці моделі;  

 Створити модель Катерининський собор; 

 Проаналізувати формат  STL; 

 Проаналізувати Формат OBJ. 

 Структура роботи. Робота складається зі вступу, двох розділів, 

висновків, списку використаних джерел та додатків. 
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РОЗДІЛ 1 

АНАЛІЗ ПРИНЦИПІВ І ТЕХНОЛОГІЇ СТВОРЕННЯ МОДЕЛІ, 

ТРИВИМІРНА ГРАФІКА 

 

1.1 Загальне уявлення про Тривимірну Графіку  

 

 Комп'ютерна графіка дозволяє створювати об'ємні тривимірні 

сцени з моделюванням умов освітлення і установкою точок зору. Для 

вивчення прийомів і засобів композиції, таких як передача простору, 

середовища, світлотіні, законів лінійної, повітряної і колірної 

перспективи тут очевидні переваги цього виду комп'ютерної графіки над 

векторної і растрової графікою. У тривимірній графіці зображення (або 

персонажі) моделюються і переміщаються в віртуальному просторі, в 

природному середовищі або в інтер'єрі, а їх анімація дозволяє побачити 

об'єкт з будь-якої точки зору, перемістити в штучно створеному 

середовищі і просторі, зрозуміло, при супроводі спеціальних ефектів. 

Комп'ютерна графіка, як і векторна, є об'єктно-орієнтованої, що дозволяє 

змінювати як всі елементи тривимірної сцени, так і кожен об'єкт окремо. 

Цей вид комп'ютерної графіки володіє великими можливостями для 

підтримки технічного креслення 

 У самій назві даної області – «тривимірна графіка» – закладено 

вказівку на те, що нам доведеться мати справу з трьома просторовими 

вимірами: шириною, висотою і глибиною. Якщо поглянути навколо: все, 

що нас оточує, має трьома вимірами – стіл, стілець, житлові будівлі, 

промислові корпуси і навіть тіла людей. Однак термін «тривимірна 

графіка» все ж це спотворення істини. На ділі тривимірна комп'ютерна 

графіка має справу лише з двовимірними проекціями об'єктів уявного 

тривимірного світу. У комп'ютерній графіці об'єкти існують лише в 

пам'яті комп'ютера. Вони не мають фізичної форми – це не більше ніж 

сукупність математичних рівнянь.   
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 Можливість опредметить будь-яку ідею потрібна була людству 

здавна. У десятки разів простіше пояснити свій задум більшості, якщо 

презентувати його в цілком зрозумілій і доступній формі – матеріальнії.  

Переважна ж більшість потребує простій і зрозумілій прикладі, який 

можна побачити, помацати руками, подумки оцінити його висоту, 

ширину, обсяг і габарити. Неймовірна обчислювальна потужність 

сучасних комп'ютерів дозволяє не просто створити об'ємне зображення 

майбутнього продукту чи макету. 

 Нинішні програми настільки розумні, що дозволяють виробляти 

необхідні обчислення в фоновому режимі. Ці обчислення стосуються 

міцності, ваги, аеродинамічних властивостей, водотоннажності, опору 

матеріалів та ще десятків і сотень параметрів.  

 Подібний підхід економить колосальна кількість ресурсів – будь то 

гроші, матеріали на виробництво або людино-години. Адже набагато 

дешевше змоделювати, наприклад, автомобіль, виявити і виправити всі 

недоліки на рівні комп'ютерної програми і лише, потім виробляти. 

 

1.2 Основні методи 3D-принтинга 

 

 Стереолітографія (SLA). У Стереолітографічному принтері лазер 

опромінює фотополімери, і формує кожен шар по 3D-кресленню. Після 

опромінення матеріал твердне. Міцність виробу залежить від типу 

полімеру - термопластика, смол, гуми. 

 Стереолітографія – це технологія одна з найдорожчих, але гарантує 

точність друку. Принтер завдає шари товщиною 15 мікрон – це в кілька 

разів тонше за людську волосину. Тому за допомогою стереолітографії 

роблять стоматологічні протези і прикраси. 

 

 Промислові стереолітографічні установки можуть друкувати 

величезні вироби, в кілька метрів. Тому їх успішно застосовують у 
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виробництві літаків, суден, в оборонній промисловості, медицині і 

машинобудуванні. 

 Селективне лазерне спікання (SLS). Найпоширеніший метод 

спікання порошкових матеріалів. Інші технології - пряме лазерне спікання 

і вибіркова лазерна плавка. 

 Технологію SLS використовують для прототипів і складних 

геометричних деталей. Для друку в домашніх умовах SLS не підходить 

через величезних розмірів принтера. 

 Пошарова заливка полімеру (FDM). FDM, або, як його ще 

називають – моделювання методом пошарового наплавлення працює так: 

матеріал виводиться в екструдер у вигляді нитки, там він нагрівається і 

подається на робочий стіл мікрокраплі. Екструдер переміщається по 

робочій поверхні відповідно до 3D-моделлю, матеріал охолоджується і 

застигає в модель виробу. 

 Переваги – висока гнучкість виробів і стійкість до температур. Для 

такої печатки використовують різні види термопластика. В основному 

моделювання пошаровим наплавленням використовують в 

прототипіюваню  і промисловому виробництві – принтери досить швидко 

друкують дрібносерійні партії виробів. Предмети з вогнетривких 

пластиків виготовляють для космічної галузі. 

 Струменевий 3D-друк. Один з перших методів тривимірного 

друку. Працює струменевий друк так: на тонкий шар матеріалу 

наноситься сполучна речовина по контурах креслення. Друкована 

головка наносить матеріал по межах моделі, і частки кожного нового 

шару склеюються між собою. Цей цикл повторюється, поки виріб не буде 

готовий. Це один з видів порошкової друку: раніше струменеві 3D-

принтери друкували на гіпсі, зараз використовують пластики, піщані 

суміші та металеві порошки.  
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 Предмети, які надрукували за цією технологією, зазвичай 

довговічні, але не дуже міцні. Тому за допомогою струминного друку 

роблять сувеніри, прикраси або прототипи.  

 Ще струменеву технологію використовують в біопдруці – за нею 

наносять живі клітини один на одного пошарово і таким чином будують 

органічні тканини. 

   

1.3. Характеристика Blender  

 

 Blender – це програмне забезпечення для створення і редагування 

тривимірної графіки. З огляду на кросплатформенність, відкритий 

вихідний код, доступний і функціональний пакет. У міру розвитку 

програми її вибирають в якості робочого інструменту для все більш 

серйозних проектів. Це додаток практично не поступається за кількістю 

можливостей і функціоналу більш просунутим пакетам 3D графіки. І при 

цьому він повністю безкоштовний. 

 На відміну інших 3D редакторів, Blender ще вміє створювати 

анімації. Для цього програма використовує :скелетну анімацію, нелінійну 

анімацію, морфінг, інверсну кінематику, різні прив’язки ключових кадрів, 

скриптову мову програмування Python та багато іншого.  

 Наразі його можна вважати повноцінним 3D редактором, в якому 

користувачі зустрічають повністю програмований інтерфейс і унікальну 

внутрішню файлову систему. В якості мови програмування 

використовується Python, вміючи користуватись яким ви зможете 

створювати власні інструменти, редагувати інтерфейс і сам принцип 

роботи програми. Програма підтримує будь яку операційну систему та 

одну на вибір розрядність системи.  

 Основні можливості Blender: 

 Підтримка різноманітних геометричних примітивів, до списку яких 

входять: система швидкого моделювання в режимі SubSurf, 
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полігональні моделі, криві Безьє, поверхні NURBS, метасфери, 

скульптурне моделювання та векторні шрифти; 

 Інструменти анімації: 

 інверсна кінематика; 

 скелетна анімація і сіткова деформація; 

 ключові кадри; 

 нелінійна анімація; 

 редагування вагових коефіцієнтів вершин; 

 обмежувачі; 

 динаміка м'яких тіл; 

 динаміка твердих тіл; 

 система волосся на основі частинок і система частинок з 

підтримкою колізій. 

 Універсальні вбудовані механізми рендеринга і інтеграція з 

зовнішнім рендерер YafRay; 

 Python використовується як засіб створення інструментів і 

прототипів, системи логіки в іграх, як засіб імпорту та експорту 

файлів, автоматизації завдань; 

 Базові функції нелінійного редагування і комбінування відео; 

 Game Blender - підпроект Blender, що надає інтерактивні функції, 

такі як визначення колізій, движок динаміки і програмована логіка. 

 

1.4 Технології та інструмент Blender 

 

 Mesh. Меши є одним з типів об'єктів Blender. Їх також називають 

сітками, полісеткамі. Це тривимірні геометричні примітиви, змінюючи 

які за допомогою базових трансформацій та інших модифікаторів. 
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Рис. 1.1 Меню вибору Mesh. 

Extrude. У Blender трансформація Extrude дозволяє створювати нові 

грані, вершини і ребра мешів шляхом свого роду видавлювання, 

найчастіше граней. 

Рис. 1.2 Приклад створення додаткового Mesh засобом Extrude. 

 Subdivide – підрозділ. Інструент для поділу ребер і граней mesh-

об'єктів на частини. У простих випадках розділяє прямокутні і трикутні 

грані на такі ж за формою більш дрібні. Якщо була виділена грань, то 

кожне її ребро буде розділено новою вершиною навпіл. 
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Рис. 1.3 Subdivide – приклад реалізації. 

 Knife. За допомогою цього інструменту можна нарізати межі 

довільно. 

 

Рис. 1.4 Knife – приклад реалізації. 

 Bevel. Інструмент для округлення, розгладжування або вигинання 

країв або кутів об'єкту.  
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Рис. 1.5 Bevel – приклад реалізації. 

Крім оригінального Extrude в Blender є такий трансформатор як Inset  

(вставка, видавлювання всередину) Faces. В регіоні інструментів він 

знаходиться під Extrude. Гаряча клавіша I. 

 

Рис. 1.6 Приклад реалізації Inset. 

 У Blender модифікатори за допомогою закладеного в них алгоритму 

змінюють об'єкт без необхідності його доробки в режимі редагування. 

Результат застосування модифікаторів зазвичай складніше, ніж 



14 
 

трансформаторів. якщо модифікатор не застосований остаточно, а лише 

доданий до об'єкта, то останній при правці залишається колишнім.  

Лише промальовується результат застосування модифікатора, але сам 

об'єкт не змінюється.В Blender доступ до модифікаторів здійснюється 

через редактор властивостей (Properties). 

 Навігаційна панель Properties складається з вкладок у вигляді 

іконок. Модифікатори знаходяться там, де зображений гайковий ключ. 

 

Рис. 1.7 Іконка модифікаторів на панелі Blender. 

 При переході взаголовку буде назва виділеного об'єкта. Саме до 

нього буде застосовуватися модифікатор. Нижче знаходиться список, що 

розкривається Add Modifier. У Blender модифікаторів багато, у кожного з 

них свої особливості і налаштування.  

 Boolean. Булеві, або логічні, операції (boolean operations) є 

предметом математичної логіки. Однак вони знайшли широке 

застосування в комп'ютерній графіці.  
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Рис. 1.8 Модифікатор Boolean. 

В Blender використовуються три операції Boolean: 

1. Перетин – Intersect; 

2. Об'єднання – Union; 

3. Віднімання – Difference; 

 Результатом перетину двох mesh-об'єктів є область їх перекриття. 

При Union (об'єднанні) відбувається з'єднання об'єктів в один. У разі 

Difference (віднімання) один об'єкт вирізає з іншого ту область, яку 

перетнув. 

 Меши зліва об'єднані за допомогою Ctrl + J, а праворуч 

використовувався модифікатор Boolean. 

 

Рис. 1.9 Приклад роботи boolean. 

 Включений режим відображення каркасд. Хоча в булевої операції 

беруть участь два об'єкти, один з них – головний – той, про якого йдеться 

в модифікаторі і який буде змінений. Другий об'єкт свого роду 

інструмента модифікації, він не змінюється і по завершенні операції 

залишається тим самим. 
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 Mirror. Інструмент дзеркального відображення, які передбачені в 

середовищах 3D-моделінованія, в тому числі Blender.Mirror, який 

відображає, тобто перевертає, а не добудовує, виділений об'єкт за 

вказаною вісю. Ключовими налаштуваннями є вісі (Axis), уздовж яких 

відбувається відображення об'єкта. Тобто уявна площина симетрії 

перпендикулярна обраної вісі. 

 

Рис. 1.10 Інструмент mirror. 

 

Рис. 1.11 Приклад роботи mirror. 

 Smooth. Через свою каркасну будову меш-об'єктів виглядають 

ребристими навіть там, де очікуються округлені форми. 

 Найпростіший варіант згладжування – через контекстне меню. 

Пункт Shade Smooth(гладке затінення). Тут же знаходиться Shade Flat 

(плоске затінення), який повертає до попереднього стану. 
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Рис. 1.12 Shade у контекстному меню. 

 

 

 

Рис. 1.13 Приклад роботи Shade Smooth та Shade Flat. 
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РОЗДІЛ 2 

СТВОРЕННЯ ГРАФІЧНОЇ МОДЕЛІ, STL-ФОРМАТ, 

ПОРІВНЯЛЬНА ХАРАКТЕРИСТИКА ФОРМАТІВ 3D 

 

2.1. Створення основи Катерининський собор 

 

 Для початку розробки макету Софіївського собору нам потрібно 

обрати одиниці вимірювання (Units).По стандарту система виміру (unit 

system) метрична, так її і залишаємо. Параметр Unit scale потрібно 

замінити з 1.0 на 0.1 щоб моделювання моделі в сантиметрах буде 

зручніше. Також потрібно переставити відображення одиниць вимірів за 

власним бажанням:  адаптивна, метрична, сантиметрична, 

мілеметрична,мікрометрична. Для виконання побудови моделі було 

обрано сантиметричну систему. 

 

Рис. 2.1 Units налаштування системи виміру. 

 Після налаштування системи виміру потрібно також замінити 

налаштування області (area). Значення scale з 1.0 на значення 0.1. 



19 
 

Це потрібно для того щоб область розроби моделі також була в 

сантиметрах, а не в blender.units.  

 

Рис. 2.2 Налаштування Areas. 

 Для початку розробки потрібно створити mesh – cube. 

 

Рис. 2.3 Створення мешу куб. 
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Після створеного мешу для отримання основи моделі використовується 

інструмент extrude(видавлювання).Функція видавлювання 

використовуються в режимі Edit mode.  

 

Рис. 2.4 Меню вибору режимів. 

  Після чого можем починати створювати основу будівлі засобом 

extrude.Робимо з меша куб методом scale (гаряча клавіша s) чи прямим 

записом розмірів в певну таблицю. 

 

Рис. 2.5 Створення передньої стіни моделі. 
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Після того як передня стіна готова методом extrude моделюються 

стіни Катерининського собору. 

 

Рис. 2.6 Основа моделі та приклад вибору меша. 

 Після створення основи моделі потрібно повернутись в об'єктний 

режим та створити новий меш циліндр для задньої заокругленої частини 

моделі. Після чого повернутись в edit mode, перейти в каскадний режим 

та видалити половину мешів та приєднати меші циліндра та задньої 

частини моделі. 

 

Рис. 2.7 Циліндр який має сталу кількість mesh та циліндр для задньої 

частини моделі. 
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Над циліндром виконана робота з видалення зайвих mesh, можна 

скористатись модифікатором Boolean – union (об’єднання) створити меш 

куб та меш циліндр в суцільний об’єкт, заповнити пусті меші після 

об’єднання допоможе гаряча клавіша “f” в edit моді. 

 Після виділення точок в edit моді потрібно обрати в панелі вибору 

меша, точки та виділити не об’єднанні і використати гарячу клавішу “f”. 

Після чого точки заповняться новим мешем і модель буде без пропусків. 

 

Рис. 2.8 Грані циліндра злиті між собою. 

Рис. 2.9 Приклад створення вікон. 
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Створення за допомогою Bloolean отворів дверей да вікон – вікна 

були створені за допомогою двух інших форм (прямокутник та циліндр) 

та модифікатором bloolean-difference. 

  Дах моделі  розроблявся методами  Extrude,  Knife та Boolean. 

Переносом точок на задані координати через панель View. 

 

Рис. 2.10 Дах моделі. 

 Об‘єднання об‘єкту “основа” та “дах” зроблена за допомогою 

засобів Boolean та редагуванням точок , після чого буд застосований 

модифікатор Subdivision surface.  

 

Рис. 2.11 об‘єднані моделі даху та основи. 



24 
 

 Після того як модель готова до експорту в stl чи obj формати її 

потрібно виправити на недоліки моделювання.Mesh → Normals → 

Recalculate Outside (Ctrl + N) (Сітка → Норми → Перерахувати зовні) 

перевертає будь-які трикутники з інвертованими нормалями. Перевірити 

інформаційну панель вгорі для результатів, в разі створення квадратів їх 

можна перетворити в трикутники за допомогою Mesh → Faces → 

Triangulate Faces (Ctrl + T). Mesh → Degenerate → Dissolve (Сітка → 

Виродження → Розчинення) видаляє ребра і грані без області. Видаліть 

дублюються вершини, щоб зварити краю разом з Mesh → Vertices → 

Remove Doubles (Сітка → Вершини → Видалити подвійні). 

 Найпростіший спосіб заповнити діру в Blender - спочатку вибрати 

граничний цикл за допомогою Select → Select Boundary Loop або виділити 

всі ребра, які не є різноманіттям, за допомогою Select → Select All за 

ознакою → Non-Manifold (Shift + Ctrl + Alt + M), а потім натисніть Mesh 

→ Faces → Make Edge / Face (F) або Mesh → Faces → Fill (Alt + F) для 

поліпшення заливки. Окремі трикутники можна створити, клацнувши 

правою кнопкою миші край або вершину, утримуючи клавішу Shift + 

клацнувши правою кнопкою миші другий і натиснувши клавішу F. Під 

час редагування корисно перемикатися між режимами Vertex Select, Face 

Select, or Edge Selec (вибору вершини, вибору профілю або вибору краю), 

які позначені трьома значками. на нижній панелі інструментів. Вибір 

певної області може бути зроблений за допомогою Select → Circle Select  

який працює аналогічно вибору кисті. Змініть розмір кисті за допомогою 

коліщатка миші або кнопок плюс / мінус, обирайте, утримуючи клавішу 

Shift. Mesh → Faces → Beautify Faces (Shift + Alt + F) іноді допомагає 

поліпшити якість сітки в обраній галузі. Окремі граничні петлі можуть 

бути обрані за допомогою Alt + правий клік. Вибравши дві відкриті 

граничні петлі, виберіть Mesh → Edges → Bridge Edge Loop і дві області 

будуть плавно з'єднані. 



25 
 

 Вибравши Mesh → Vertices → Separate → By loose parts, ви створите 

один об'єкт на оболонку в браузері проекту. Це дозволяє видаляти 

непотрібні об'єкти сітки. Окремі оболонки можна об'єднати за допомогою 

логічного модифікатор.  

Рис. 2.12 Каркасний вид моделі. 

 

Рис. 2.13 Дах моделі Катерининського собору. 
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Рис. 2.14 Бокова частина моделі Катерининського собору. 

 

2.2 Характеристика формату STL 

 

Найбільш поширене пояснення полягає в тому, що це скорочення 

від слова Stereolithography, даного 3D Systems, хоча іноді його називають 

«стандартною мовою трикутників» або «стандартною мовою тесселяції». 

Файл STL зберігає інформацію про вашу 3D-моделі. Формат представляє 

необроблену поверхню моделі складається з маленьких трикутників. Чим 

складніше і детальніше структура, тим більше трикутників буде 

використано для представлення моделі. 

 Приклад того, як це працює: якщо у вас є простий 3D-куб, він може 

бути покритий 12 трикутниками, як показано на малюнку нижче. Як 

бачите, на обличчі є два трикутника. Оскільки куб має шість граней, він 

додає до 12 трикутників. 
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Рис. 2.15 Приклад 3D куба. 

 3D-модель сфери, вона може бути покрита безліччю маленьких 

трикутників. 

 

Рис. 2.16 3D модель сфери. 

 Формат файлу STL забезпечує два різні способи зберігання 

інформації про трикутних гранях, які описують поверхню об'єкта. Вони 

називаються кодуванням ASCII і двійковим кодуванням. В обох форматах 

зберігається наступна інформація про кожному трикутнику: 

1. Координати вершин. 

2. Компоненти одиничного вектора нормалі до трикутника. Вектор 

нормалі повинен вказувати назовні щодо тривимірної моделі. 
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Рис. 2.17 Приклад збереження файлу. 

 Формат файлу ASCII STL. Файл ASCII STL починається з 

обов'язкового рядка: solid <name>, де <name> – це назва 3D-моделі. Ім'я 

можна залишити порожнім, але в цьому випадку після слова solid повинен 

бути пробіл. 

 Файл тримає інформацією про покривання трикутниками. 

Інформація про вершини і вектори нормалі представлена наступним 

чином: 

 facet normal nx ny nz 

 outer loop 

 vertex v1x v1y v1z 

 vertex v2x v2y v2z 

 vertex v3x v3y v3z 

 endloop 

 endfacet 

 Тут n – нормаль до трикутника, а v1, v2 і v3 – вершини трикутника. 

Значення координат представлені у вигляді числа з плаваючою комою в 

форматі знак-мантиса-е-знак-експонента, наприклад, «3.245000e-001». 

 Файл закінчується обов'язковим рядком: 

 endsolid <name> 
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 Бінарний формат файлу STL. Якщо в теселяції багато маленьких 

трикутників, файл ASCII STL може стати величезним. Ось чому існує 

більш компактна двійкова версія. 

 Двійковий файл STL починається з 80-символьного заголовка. Це 

зазвичай ігнорується більшістю програм читання файлів STL. Після 

заголовка загальна кількість трикутників вказується з використанням 4-

байтового цілого числа без знака. 

 UINT8  – Тема; 

 UINT32 – Кількість трикутників. 

 Кожен трикутник представлений дванадцятьма 32-бітними числами 

з плаваючою комою. Як і в файлі ASCII STL, 3 числа відносяться до 

тривимірним декартових координатах нормалі до трикутника. Решта 9 

чисел призначені для координат вершин (по три в кожній). Ось як це 

виглядає: 

 foreach triangle; 

 REAL32  – нормальний вектор; 

 REAL32  – вершина 1; 

 REAL32  – вершина 2; 

 REAL32 – вершина 3; 

 UINT16 – кінець підрахунку байтів атрибута. 

 Після кожного трикутника є 2-байтова послідовність, яка 

називається «лічильником байтів атрибута». У більшості випадків це 

значення дорівнює нулю і діє як роздільник між двома трикутниками. Але 

деякі програми також використовують ці 2 байта для кодування 

додаткової інформації про трикутнику. 

 Перевагами STL-технологій є: 

 Дуже висока якість друку і точність копії;  

 Відмінна швидкість друку;  

 Можливість використання різних термопластів; 



30 
 

 Можливість творчої доопрацювання наявних зразків; 

 Можливість швидкої організації бізнесу для невеликого колективу. 

 Можливість створення унікальних виробів. 

 Швидке обмін моделями виключно для 3D друку. Файли STL 

набагато менші та менш складні. Практично всі програмні платформи для 

зрізів здатні відкривати файли STL, при цьому деякі версії призначені для 

відкриття тільки STL. 

  Публікація ваших моделей на загальнодоступній платформі, 

наприклад Thingiverse. За допомогою STL-файлу кожен може 

завантажити та роздрукувати вашу модель, але змінити її буде не так 

складно.  

 До недоліків STL-технологій належать: 

 Досить висока вартість сучасного обладнання; 

 Підготовка обладнання до роботи і сам процес друку вимагає 

спеціальної підготовки; 

 Дуже висока вартість «одноразової» продукції через високу       

вартість фотополімерів. 

 

2.3 Характеристика формату OBJ 

 

 Формат файлу OBJ є ще одним нейтральним важковаговиком в 

області 3D-друку. Він також широко використовується в 3D-графіці. 

Формат файлу 3D має розширення .OBJ. 

 Формат файлу OBJ підтримує як приблизне, так і точне кодування 

геометрії поверхні. При використанні приблизного кодування це не 

обмежує поверхню сітки трикутними гранями. Якщо користувач хоче, він 

може використовувати багатокутники, такі як чотирикутники (Quad 

Mesh). При використанні точного кодування використовуються гладкі 

криві і поверхні, такі як NURBS. 
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 Формат OBJ може кодувати інформацію про колір і текстурі. Ця 

інформація зберігається в окремому файлі з розширенням. MTL 

(бібліотека шаблонів матеріалів). Він не підтримує жодної анімації. 

Формат визначає як ASCII, так і виконавчі кодування, але тільки 

кодування ASCII має відкритий вихідний код. 

 Формат файлу OBJ, завдяки своїй нейтральності або відкритості, є 

одним з найбільш популярних форматів обміну для 3D-графіки. Та також 

набирає обертів в індустрії 3D-друку, оскільки індустрія рухається до 

повнокольорового друку. 

 По-перше, формат файлу OBJ – це простий і відкритий формат. Має 

широку підтримку експорту і імпорту програмного забезпечення САПР. 

Це означає, що якщо ви поділитеся своєю 3D-моделлю у вигляді файлу 

OBJ, то інше програмне забезпечення САПР буде інтерпретувати її 

правильно і послідовно. Те ж саме можна сказати про формати FBX або 

COLLADA. Формат COLLADA також є відкритим вихідним кодом, але 

він досить складний. Різне програмне забезпечення CAD інтерпретує це 

по-різному, і це призводить до невідповідностей. 

 Файл OBJ також буде набагато легшим і невеликим порівняно з 

файлом FBX або файлом COLLADA тієї ж 3D-моделі. Це відбувається 

через простоту формату файлу OBJ в порівнянні з іншими 

специфікаціями і через його власного двійкового кодування. 

 Таким чином, якщо вам не потрібна повна сцена або анімація, і ви 

піклуєтеся про підтримку і послідовної інтерпретації різними програмами 

CAD, формат файлу OBJ є правильним форматом. Майже у всіх інших 

випадках FBX є оптимальним форматом для додатків з тривимірною 

графікою. 

 Геометрія OBJ. Основне призначення формату файлу OBJ полягає 

в кодуванні геометрії поверхні тривимірного об'єкту. Формат файлу OBJ 

досить універсальний в цьому відношенні. Це дозволяє кілька варіантів 

кодування геометрії поверхні. 
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 Криві вільної форми у форматі OBJ. Формат файлу OBJ також 

дозволяє задавати геометрію поверхні моделі з використанням кривих 

довільної форми. Основна ідея полягає в тому, що користувач визначає 

набір кривих вільної форми (кардинальні сплайни, криві Безьє тощо), які 

проходять по поверхні моделі. Поверхня потім апроксимується з цього 

набору кривих. 

 

Рис. 2.14 Ілюстрація кривої вільної форми на поверхні 3D-моделі. 

 Криві довільної форми складніші, ніж полігональні межі. Але, 

пожертвувавши простотою, ми теж багато виграємо. Оскільки криві 

довільної форми можуть точно описувати криві лінії з використанням 

декількох математичних параметрів, їм потрібно набагато менше даних 

для опису однієї і тієї ж поверхні в порівнянні з наближеним методом, 

таким як полігональні тесселяція. Можемо створити високоякісне 

кодування будь якої 3D-моделі, використовуючи криві довільної форми, 

не збільшуючи розмір файлу. 

 Перевагами формату OBJ вважають: 

 Обмін моделями спільної роботи. З файлом OBJ ваша оригінальна 

модель, якщо вона відкрита для модифікації або вдосконалення, або 

для ваших колег, або навіть для широкої громадськості. Найкраще, 
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що OBJ-файл є сумісним з різними програмними платформами 

CAD. 

 Якщо вам потрібно опублікувати модель у форматі, що зберігає її 

початкові сітки та інші текстурні дані. Окрім відкритості до 

модифікацій, збереження текстурних даних може мати вирішальне 

значення для високої роздільної здатності або повнокольорового 

3D друку. 

 Збереження моделі для подальшої модифікації. Якщо ви працюєте 

над проектом 3D-моделювання, який, на вашу думку, ви хочете 

вдосконалити пізніше, вам доведеться зберігати його у форматі 

файлів OBJ. 

 Експорт моделі для використання в анімації або ігровому двигуні. 

Це вузькоспеціалізовані програми 3D-моделювання. Візуальну 

привабливість, як правило, бажану для ігор чи анімації, можна 

досягти лише збереженням відображення текстури в моделі. 

 

2.4 Порівняння STL та OBJ 

 

 Велика різниця між сітками STL та OBJ – це те, що відображається 

на поверхні. Файли STL не відображають даних на поверхні сітки. Вони 

вказують лише саму поверхню – геометрію об'єкта, наскільки вона велика 

і форму її сторін, але це лише про неї. Ось чому STL – це кольори сірого 

за замовчуванням, оскільки немає даних про колір або текстуру. 

 Файли OBJ, з іншого боку, містять фактичні фотографічні знімки, 

зняті камерою під час сканування та відображення їх на поверхні 

полігонів, що містяться в сітці. 

 Карта текстури – це всі фотографії, зроблені під час сканування, 

поєднані та розбиті на багатокутники. Коли ви відкриєте файл OBJ, ви 

помітите, що він супроводжується .PNG файлом; це ваша карта текстури. 
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Вони насправді є приголомшливими, хоч і не дуже зручними у 

використанні для людини. 

 Під час експорту до OBJ програмне забезпечення бере карту 

текстури і обертає її навколо поверхні сітки, порівнюючи поліси на карті 

текстури з тими, що зроблені за допомогою хмари точок. В результаті 

виходить різко реалістична 3D-модель, яка має повний колір та 

деталізацію. 

 Файл STL є важливим аспектом 3D-друку, оскільки він служить 

інтерфейсом між 3D-моделлю та 3D-принтером. Крім того, важливо знати 

про STL-файли, особливо якщо ви плануєте робити 3D-друк.  
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ВИСНОВКИ 

 

У ході виконання роботи були виконані наступні завдання: 

 Аналіз актуальності 3D печаті та загальний опис тривимірної 

графіки; 

 Проаналізовано інструментарій програми Blender: 

           mesh, extrude, subdivide, knife, bevel, inset, boolean, mirror, smooth; 

 Розглянуто модифікатори Blender та охарактеризована їх робота, 

яку показано  прикладами на mesh Blender; 

 Описано інструменти та модифікатори, які застосовуються під час 

розробки моделей та описана функціональна частина кожного з 

модифікаторів; 

 Створено модель Катерининського собору, на якій ми показали 

послідовний процес створення 3D-моделі у програмі Blender; 

 Розглянуто формати  STL та OBJ, а також проведено  порівняльний 

аналіз форматів STL та OBJ. 

 Таким чином нами було проведено роботу із проєктування моделі 

Катерининського собору, який є частиною парку Херсонська фортеця,  

експортовано у двох форматах STL та OBJ. 
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